Welcome

Thank you for purchasing Blackmagic Cinema Camera!

We have worked hard to produce a camera that’s designed from the ground up to have a very wide dynamic range and to produce files that are “flat”, which means they preserve this wide dynamic range. This will allow you to make your creative decisions by using the included DaVinci Resolve 9 color correction tools!

We think this means you get a cinema style shooting experience where you capture and preserve more of the image so you have as many creative options as possible. An added benefit of the 2.5K sensor is you capture more pixels than you need for HD so your HD images get a wonderful anti aliased look, similar to shooting film!

We have also included a large screen for easy focus and metadata entry as well as standard file formats that work with all video software. We hope you connect to this camera in a creative way and produce some amazing looking images! We will be extremely excited to see what creative work you produce!

Grant Petty
CEO Blackmagic Design
28 Attaching Accessories
   Sun Shield 28
   Carry Strap 28
   Blackmagic Cinema Camera Handles 29

30 Working with Thunderbolt Technology
   What Can I Do with the Thunderbolt Port on My Camera? 30

31 Using Blackmagic Media Express

39 Using Blackmagic UltraScope

51 Help
   Getting Help 51
   Blackmagic Design Online Support Pages 51
   Contacting Blackmagic Design Support 51
   Checking the Version Currently Installed 51
   How to Get the Latest Software Updates 51
   Battery Replacement 51
   Replacing the Fan 52

53 Warranty Information
Getting started with the Blackmagic Cinema Camera is as simple as attaching a lens, turning the camera on and inserting a SSD. You can test the camera by recording and playing back your first shot and, of course, don’t forget to charge the battery before you start shooting!

**Attaching a Lens**

Before you attach a lens to the camera, you’ll need to remove the camera's dust cap from the lens mount. You can then attach and remove your favorite EF and ZE mount lenses. When no lens is attached to the camera, don’t forget to replace the camera’s dust cap.

**Dust Cap**

To remove the protective dust cap from the lens mount, hold down the locking button and rotate the cap in a counterclockwise manner until its dot reaches the 12 o’clock position. The mounting points should now be aligned, and the cap should easily lift off.

To replace the dust cap, align the dot on the mounting ring with the dot on the dust cap and turn in a clockwise fashion until locked into place.

**Attaching and Removing a Lens**

The Blackmagic Cinema Camera is compatible with EF and ZE mount lenses. We recommended that you always turn off your Blackmagic Cinema Camera prior to attaching or removing a lens.

To attach a lens, first remove the protective dust cap from the Blackmagic Cinema Camera and also the rear cover from your desired lens. Many lenses have a colored dot (typically blue, red or white) or other indicator, which you should align with the dot on the camera mount. Then twist the lens in a clockwise direction until the lens locks into place.

To remove the lens, hold down the locking button, rotate the lens counterclockwise until its dot or indicator reaches the 12 o’clock position and gently remove.

**Turning the Camera On and Off**

The camera’s power button is located below the touchscreen. Press the power button to turn it on and the status strip will appear along the bottom of the touchscreen. Hold the power button for 2 seconds to switch off the camera.
Inserting a SSD

You can insert any 2.5" SSD formatted in either the HFS+ or exFAT file systems:

**Step 1.** Open the SSD door on the right hand side of the camera.

**Step 2.** With the gold SATA contacts facing towards the camera door, insert the SSD until you feel it press into place.

**Step 3.** Close the SSD door.

When you first switch on Blackmagic Cinema Camera, or any time you insert a SSD into the SSD slot, the status strip will change from NO SSD to a moving dot while checking the SSD, and then READY. If the SSD has not been formatted correctly, or fails to work, the status strip will show NO SSD. Remove the SSD and refer to the later section “About SSDs” to check if the SSD is formatted correctly and also check that it works with a computer. If it doesn’t work with a computer, there’s something wrong with the SSD and it’s not going to work with your camera. Try another SSD and preferably use a model that is on the recommended SSD list in the “About SSDs” section of this manual.

Begin Recording

To record with your Blackmagic Cinema Camera, insert a SSD and press the REC button on the front face of the camera or the record button in the transport control under the touchscreen. Press record again to stop recording. This is all you need to do to record unless you prefer to record in a different video format.

Choosing the Recording Format

You can choose to record to CinemaDNG RAW 2.5K video or to a compressed, high definition, QuickTime movie in Apple ProRes 422 (HQ) or Avid DNxHD video formats. To select the desired video format:

**Step 1.** Press the MENU button below the touchscreen.

**Step 2.** Press the REC menu icon on the touchscreen.

**Step 3.** Press the left-right selection arrows to set the desired recording format.

**Step 4.** Press the MENU button again to exit.

Your camera is now ready to record in the video format you have selected. The current recording format is shown at the bottom left of the touchscreen display.
Playing Back Clips

Recorded clips can be played back on the camera’s touchscreen. Once you have recorded your video, you can use the transport control buttons under the touchscreen to play back your video.

Press the play button once for instant playback and you’ll see your video on the touchscreen and on any display connected to the SDI output. Hold down the forward or reverse buttons to fast forward or reverse through the clip. Playback will finish when the end of the current clip is reached.

The controls of your camera work just like a CD player, so pressing the forward button will skip to the start of the next clip. Press the reverse button once to go to the start of the current clip or press twice to skip back to the start of the previous clip.

Using Remote Control

The remote port on your camera can be used to remotely control the following functions of your camera including starting and stopping record, iris adjustments and also focus adjustments when using a compatible lens.

The remote port can be found under its dust cap on the left face of the camera. The port is a 2.5 mm stereo jack which uses the standard Sony LANC protocol.

Charging the Internal Battery

The camera’s internal battery can be charged using the supplied DC adapter. Alternatively, you can use any DC power source between 11V and 30V to charge the battery.

The camera can be charged and operated while connected via DC power. You can also charge the camera via a powered USB connection. However, it takes a longer time to charge the camera via USB so we recommend using the DC adapter when possible.
Blackmagic Cinema Camera Utility

Blackmagic Cinema Camera Utility is used to change settings and update the internal software in your camera.

How to Update Your Cinema Camera Software on Mac OS X
After downloading the Blackmagic Cinema Camera Utility software and unzipping the downloaded file, open the resulting disk image to reveal its contents.
Launch the Blackmagic Cinema Camera Installer and follow the onscreen instructions.

How to Update Your Cinema Camera Software on Windows
After downloading the Blackmagic Cinema Camera Utility software and unzipping the downloaded file, you should see a Blackmagic Cinema Camera Utility folder containing this PDF manual and the Blackmagic Cinema Camera Utility installer.
Double-click the installer and follow the onscreen prompts to complete the installation.

How to Update the Internal Software
After installing the latest Blackmagic Cinema Camera Utility on your computer, connect a USB cable between the computer and the camera. Launch the Blackmagic Cinema Camera Utility and follow any onscreen prompt to update the internal software in your camera.
How to Set Up Thunderbolt to Capture and Monitor Video

This section guides you through how to set up your Blackmagic Cinema Camera with your computer for video capture and waveform monitoring.

Connecting the Blackmagic Cinema Camera to your computer

Step 1. Connect power to the Blackmagic Cinema Camera using the included power adapter. Battery power can be used but you’ll usually want to connect the power adapter for longer sessions.

Step 2. Connect a Thunderbolt cable between the Thunderbolt port on the Blackmagic Cinema Camera and a Thunderbolt port on your Mac OS X computer, or to a Thunderbolt disk array which is attached to your Mac OS X computer.

Step 3. Use your camera to record or play back video so that your video software can obtain a video signal from the camera.
To configure camera settings on your Blackmagic Cinema Camera, press the MENU button in the transport control and tap the onscreen camera menu icon.

### Camera ID

If you’re using more than one Blackmagic Cinema Camera, it can be helpful to set a camera ID which will be included with any metadata recorded with your clips. You can change the camera ID by tapping the current name and then changing or entering a new camera ID with the onscreen keyboard. Use the Enter button to save the new camera ID or press Cancel to discard any changes.

### Setting Date and Time

To set date and time on your Blackmagic Cinema camera, press MENU button and change the year, month and day settings to the correct date.

To set the time, adjust the time settings on the screen to the desired time in 24 hour format. You will need to manually change the date and time to local time zones if traveling with your Blackmagic Cinema Camera.

If you have your Blackmagic Cinema Camera stored for a length of time, the clock may become inaccurate. It is always a good idea to check the time and date prior to recording. If you connect the camera via USB to your computer and run the Blackmagic Camera Utility, the camera time will also be synced with your computer’s time.

### ISO

ISO settings are helpful when you are shooting in a variety of light conditions. The optimum ISO setting for the Blackmagic Cinema Camera is 800ASA. Depending on your situation, however, you may choose a lower or higher ISO setting. For example, in low light conditions 1600ASA would be suitable but might introduce some visible noise. In bright conditions 400ASA would be best to record richer colors.

To adjust the ISO settings, tap the arrow icons on the touchscreen.
White Balance

Your Blackmagic Cinema Camera includes 6 white balance presets for a variety of color temperature conditions. These are

- 3200K for tungsten light
- 4500K for fluorescent light
- 5000K, 5600K, 6500K and 7500K for a variety of daylight conditions such as time of day

To adjust the White Balance settings, tap the arrow icons on the touchscreen.

Shutter Angle

Shutter angle compliments the ISO setting by regulating the amount of light on the sensor. 360 degrees is considered wide open and will retain a significant amount of motion blur. This would be best for extremely low light conditions as it allows maximum light on to the sensor, however it is best suited to low impact sequences otherwise motion blur will be obvious.

While 180 degrees is commonly regarded as a normal shutter angle, you may need to use a Shutter Angle of 172.8 degrees to minimize flickering lights when shooting 24p in countries with 50 hertz power supplies. You can use any shutter angle to shoot 24p in countries with 60 hertz power supplies and most people will choose 180 degrees for a normal look.

To adjust the shutter angle settings, tap the arrow icons on the touchscreen.
Audio Settings

To adjust audio input and audio monitoring settings on your Blackmagic Cinema Camera, press the MENU button and select the microphone icon to the left of the touchscreen display.

Microphone Input

Microphone input adjusts the built-in microphone. Drag the audio slider icon to increase or decrease levels. The mono microphone input is recorded to audio channels 1 and 2 when no external audio source is connected to the camera.

Channel 1 and Channel 2 Input Levels

The external audio inputs accept audio at microphone level or line level. It's important to select Mic or Line level audio as appropriate to avoid your external audio sounding almost inaudible or too hot and distorted.

Set the external audio input levels by using the left and right arrows. To prevent damage, the camera will automatically switch to line level input if the input levels are over the limit for a sustained period of time.

Channel 1 Input

Drag the audio slider icon for channel 1 to increase or decrease levels. The external audio input overrides the built-in microphone and is recorded to audio channel 1.

Channel 2 uses Channel 1 Input

Use this setting if you only have channel 1 input and want to record the same external audio to channels 1 and 2. Press the Off button to change it to On. Press the On button if you want to change it back to Off.

Channel 2 Input

Drag the audio slider icon for channel 2 to increase or decrease levels. The external audio input overrides the built-in microphone and is recorded to audio channel 2.

Headphone Volume, Speaker Volume

When headphones are connected, a headphone icon will be displayed. When no headphones are detected, a speaker icon will be displayed. Headphones will always be active when recording or playing back, however speakers will only work when playing back. Drag the volume slider to increase or decrease volume levels for audio monitoring.
Recorder Settings

The recorder settings are used to set the video format recorded to the built-in SSD recorder. To set recorder settings on your Blackmagic Cinema Camera, press the MENU button in the transport control panel and then tap the onscreen REC icon.

Recording Format

You can choose to record to CinemaDNG RAW 2.5K video or to a compressed, high definition, QuickTime movie in Apple ProRes 422 (HQ) or Avid DNxHD video formats. Choose RAW 2.5K for maximum quality, especially if you intend to color grade your video. Choose ProRes or DNxHD if you want to record in a high definition format suitable for broadcast.

To select the recording format, tap the arrow icons on the touchscreen.

Dynamic Range

Your Blackmagic Cinema Camera has two dynamic range settings, Film and Video, which are available when ProRes or DNxHD is selected as the recording format.

Film

The film setting shoots video using a log curve and gives you 13 stops of dynamic range, which increases contrast levels to help you get the most out of color grading software such as DaVinci Resolve.

Video

The video setting uses the REC709 standard for high definition video which lets you work faster by recording directly to the Apple ProRes 422 (HQ) or Avid DNxHD video formats, which are compatible with popular post production software.

To select the dynamic range, tap the arrow icons on the touchscreen.
Frame Rate

Your Blackmagic Cinema Camera has five different frame rate settings for shooting common film and video frame rates: 23.98 fps, 24 fps, 25 fps, 29.97 fps, 30 fps.

To select the frame rate, tap the arrow icons on the touchscreen.

Time Lapse Interval

This setting allows you to record individual frames at interval ranges of 1 - 10 seconds or 1 - 10 minutes. For example, you can set the camera to record a still frame every 5 minutes. The format of each still frame is based on your recording format, so if you set the camera to record in ProRes, the time lapse setting will maintain this format. The frame rate will be based on the video frame rate you have set the camera to, i.e., 24fps, so your time lapse footage can be incorporated into your workflow easily.

To select the time lapse interval, tap the arrow icons on the touchscreen or leave it set to Off if you do not want to use the time lapse feature.
**Display Settings**

To adjust the display settings for the camera’s touchscreen, press the MENU button and select the television icon on the touchscreen.

**Dynamic Range**

The touchscreen serves as your viewfinder, allowing you to view your video as you are recording. You can set the dynamic range of your viewfinder by tapping the onscreen television icon and selecting video or film.

The dynamic range of the display is set independent of the recorder settings. Some people prefer to monitor video with the touchscreen display set to “video” even when the recording format is set to “film”.

To select the dynamic range, tap the arrow icons on the touchscreen.

**Brightness, Contrast**

Adjust the brightness and contrast settings by tapping the touchscreen and sliding the control to the left or right to achieve desired levels for comfortable viewing.

**Zebra + Warning Level**

The Blackmagic Cinema Camera has a zebra feature which gives an indication of exposure levels. Diagonal lines will appear across any part of the video which exceeds the zebra exposure level.

Turn zebra on and select the desired zebra warning level by using the left and right arrows.

**SDI Overlays**

The SDI Overlays setting lets you display useful information on your SDI monitor. Tap the arrow icons on the touchscreen to select which overlays to display on your SDI feed.

- **All**: displays both frame guides and recording information.
- **Status**: displays only the recording information, such as f-stop number, frame rate, battery life etc.
- **Guides**: displays only the frame guides.
- **Off**: gives you a clean SDI feed.
Adjusting Settings

Your Blackmagic Cinema Camera supports electronic iris control, focus peaking and image stabilization and is compatible with cinema style EF and some ZE mount lenses, all of which have the highest optical quality.

Iris Button and Control

You can also manually adjust the iris of your lens by using the forward and reverse buttons on the transport control panel.

When shooting using the Video dynamic range, exposure will be set using an average similar to what you’re used to on a stills camera. However, in Film dynamic range, the IRIS button adjusts your exposure to ensure that nothing in your scene is clipped.

Focus Button

The FOCUS button allows you to sharpen the images without affecting your recorded picture, as it creates a peaking edge around the sharpest part of the image to confirm focus.

To turn on, press the FOCUS button located near the top-right of the touchscreen.

The FOCUS button turns on focus peaking, which highlights the edges in your scene that are in focus and helps you get accurate focus when using manual lenses.

Focus Zoom - Double Tap

Double tap the touchscreen display to zoom into the image to help you adjust focus at the 1:1 pixel scale. Double tap the display again to zoom out.

Image Stabilizer

Blackmagic Cinema Camera supports the image stabilizer (IS) feature found in many EF lenses. Simply set the Stabilizer switch to ON to use it with your camera. If your lens also features a Stabilizer Mode switch, set it to the appropriate mode for still shots or for movement.

When using battery power, the camera will only activate the image stabilizer while recording as the lens draws additional power from the camera to operate the image stabilizer. When external power is connected to the camera, the image stabilizer will be active any time you set the lens’ stabilizer switch to ON.
Along the bottom of the touchscreen is a status strip that contains a convenient summary of the recording settings that have been chosen through the various menus. This information is displayed in the following order from left to right on the strip:

- **Format** - ProRes, DNxHD or RAW 2.5K
- **F-Stop number**
- **Frame Rate**
- **SSD Status**
- **Timecode / Record duration / Playback duration (based on entire clip)**
- **ISO Setting**
- **Shutter Angle Setting**
- **White Balance Setting**
- **Battery Life Indicator**

There are two important indicators on the status strip to note.

**Battery Life Indicator**

When the remaining charge drops below 25% capacity, the status strip will show the battery status in red to warn you that battery life is running low.

**SSD Status**

The status strip displays important information showing the state of the inserted SSD.

- **Moving Dots** When you see the moving dots, the camera is checking and preparing the SSD.
- **No SSD** This means no SSD is detected or present in the camera.
- **Ready** Ready to Record.
- **Rec** Recording.
- **Rec flashing** Dropped Frames were detected.
- **Disk Full** Flashes when disk is almost full.
- **Playback mode** Shows play, fast forward and reverse icons.
- **Time** During capture, this shows the duration of the current shot. When playing back clips from the SSD, this shows the time of the clip in relation to the clips on the SSD.
Entry of Metadata

What is the Slate? - Single Tap

The large touchscreen on the Blackmagic Cinema Camera has many purposes, one of which is to allow you to easily log metadata directly into the camera. Tap the display once with your finger and a data entry window called the ‘slate’ will appear.

This data is referred to as ‘metadata’. The metadata is stored in the files and is easily accessed by NLE software when editing content.

How to Enter Metadata Information

Tap once on the touchscreen to make the slate appear.

To enter or change details, tap the text that you wish to change and an onscreen keyboard will appear.

Type in the desired information and press the save button.

If you want the scene, shot or take number to auto-increment, tap the corresponding auto-increment icon so it is illuminated. Tap it again if you want to turn off the auto-increment feature.

Entering words into the Keywords field will allow you to use them as search terms in your library database. This may be particularly useful for large projects where you have a lot of material to sort. The use of keywords narrows down the number of clips to search through, saving valuable time when you are editing a project.

All metadata is compatible with popular software such as Final Cut Pro X and DaVinci Resolve.

Focus Zoom - Double Tap

Double tap the touchscreen display to zoom into the image to help you adjust focus at the 1:1 pixel scale. Double tap the display again to zoom out.
Connections

The Blackmagic Cinema Camera features standard connections, so custom cables are not required. Connections are located on the left side of the camera and are protected from dust and dirt by rubber hoods.

Remote
The 2.5mm stereo jack for remote connection uses the standard LANC protocol to support record start, record stop, iris control and manual focus.

Headphones
3.5 mm stereo headphone jack connection.

Audio In
Audio in is via ¼” TRS jack/mic. Balanced audio inputs accept mic or line level audio for recording the highest quality uncompressed audio. Audio settings are accessed via the touchscreen to select between mic and line level audio.

SDI Out
The BNC port provides 3 Gb/s SDI output and lets you monitor on set or send video to an SDI router. The SDI output of your Blackmagic Cinema Camera always outputs 10-bit 4:2:2 high definition 1920 x 1080 video regardless of whether you are recording RAW 2.5K, ProRes or DNxHD to your SSD.

When SDI Overlays are set to on in the display settings, the SDI output also shows action safe and title safe frame guides as well as the camera status strip.

Thunderbolt™
The Blackmagic Cinema Camera features a Thunderbolt port to capture video to your computer using the included DaVinci Resolve color grading software or Blackmagic Media Express. Alternatively Thunderbolt can be used with the included Blackmagic Design UltraScope software for waveform monitoring. For more information about DaVinci Resolve, please refer to the accompanying manual.

Power
12 – 30V DC input for power and battery charging.

USB
A mini-USB 2.0 port is located on the right hand side of the camera, behind the SSD door, to allow you to update the internal software of the camera with the latest Blackmagic Cinema Camera Utility software.
Connections

Blackmagic Cinema Camera

- LANC 2.5 mm Remote Control
- 3.5 mm Headphone Socket
- ¼” balanced jack mic and line level audio inputs
- 3 Gb/s SDI Output
- Thunderbolt Port
- 12-30 V DC Power Input
Accessing Clips

File Naming Convention

The Blackmagic Cinema Camera uses the following file naming convention when recording video.

\[\text{Camera ID} \_ \text{[Reel Number]} \_ \text{[yyyy-mm-dd]} \_ \text{[hhmm]} \_ \text{[Clip number]}.mov\]

This is an example of how this would appear on the touch screen of the camera:

<table>
<thead>
<tr>
<th>QuickTime Movie Filename</th>
<th>Camera ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC01_1_2012-08-08_1631_C0002.mov</td>
<td>BMC01_1_2012-08-08_1631_C0002.mov</td>
</tr>
<tr>
<td>Reel Number</td>
<td>BMC01_1_2012-08-08_1631_C0002.mov</td>
</tr>
<tr>
<td>Date (2012 Aug 08)</td>
<td>BMC01_1_2012-08-08_1631_C0002.mov</td>
</tr>
<tr>
<td>Time (16:31pm - 24hrs)</td>
<td>BMC01_1_2012-08-08_1631_C0002.mov</td>
</tr>
<tr>
<td>Clip Number</td>
<td>BMC01_1_2012-08-08_1631_C0002.mov</td>
</tr>
</tbody>
</table>

For CinemaDNG files, the folder of the image sequence will also be named the same way.

Accessing Clips Recorded to SSD

Clips recorded to the built-in SSD recorder in your camera are recorded in the CinemaDNG RAW format or to a ProRes or DNxHD QuickTime movie depending upon which recording format you have chosen in the Recorder Settings menu.

CinemaDNG files use an open format which can be opened in applications such as DaVinci Resolve 9 which is included with your camera. CinemaDNG comprises a folder of regular DNG files which can be opened by many software applications. Due to differences in the ways that software applications treat RAW DNG files, you can get varying “looks,” including files that look clipped, even when all the information is still available in the file.

ProRes and DNxHD QuickTime movies can be opened by many software applications including Apple Final Cut Pro 7 and X, Adobe After Effects CS6, Adobe Premiere Pro CS6, Avid Media Composer 6.x, Blackmagic Media Express 3 and DaVinci Resolve 9.
Capturing from the Thunderbolt™ connection

The Thunderbolt port of your camera outputs uncompressed 4:2:2 10-bit HD1080 video while recording live with the camera.

You can capture video from the Thunderbolt port with a variety of video software supported by your camera, including: Apple Final Cut Pro 7, Adobe Premiere Pro CS6, Avid Media Composer 6.x, Blackmagic Media Express 3 and DaVinci Resolve 9. Each of these applications have their own project preferences which let you capture the video in an uncompressed or compressed video format of your choice.

Capturing from SDI

The SDI port of your camera outputs uncompressed 4:2:2 10-bit HD1080 video while recording live with the camera. Make sure the SDI Overlays are set to “off” in the camera’s display settings to avoid the SDI output showing action safe and title safe frame guides as well as the camera status strip.

You can capture the HD-SDI video output from the camera with any HD-SDI capture hardware, and with any video software supported by your capture hardware on Mac OS X, Windows or Linux. Each of these applications have their own project preferences which let you capture the video in an uncompressed or compressed video format of your choice.

You could also record the HD-SDI video output to a traditional tape deck or to an HyperDeck SSD recorder for a redundant and portable backup of your recording.
RAW Files

Why do my RAW shots look overexposed?

The 100% Zebra level in the Display Settings helps you adjust your exposure to ensure that you don’t overload the sensor and clip your highlights. It is based on the full dynamic range capability of the Blackmagic Cinema Camera and not on video levels. A quick way to ensure you do not allow the sensor to clip any image data is to set your Zebra level to 100%, expose your shot such that zebras start to appear and then back it off until the zebras disappear. If you have an auto iris lens on the camera, pressing the IRIS button will do this automatically for you by adjusting the lens aperture to keep the white peaks just below the sensor’s clipping point.

If you normally expose your shots based on an 18% gray card at 40 IRE video levels, then your RAW images will look correct when imported into DaVinci Resolve. However, if you want to maximize your camera sensor’s signal to noise ratio, you might expose your shots so the white peaks are just below the sensor clipping point. This may cause your RAW images to look overexposed when a video curve is applied to the preview, and the highlights you thought were safe will look as though they have been clipped. This is normal and all the details are still retained in the file. If there is a lot of contrast range in the shot, the RAW images may look fine and not overexposed.

Shooting in RAW captures a very wide dynamic range. However, you might only see the image in the more limited Video range when you open the CinemaDNG files in a compatible application. If the camera is not exposed based on 18% or another video related exposure guide, the RAW files will look over or under exposed depending on the dynamic range of the scene.

The good news is that you have not really lost any information in your shots. Based on the contrast range of your shot, you can creatively adjust the exposure settings of the DNG file for the look you want using software such as DaVinci Resolve, Adobe Photoshop or Adobe Lightroom.

To recover the highlights not displayed in Resolve, use the RAW image settings and adjust the Exposure values so the details you need fit within the video range. Exposing your shot to the point just before the sensor clips, ensures you are getting the best signal to noise ratio for the maximum flexibility during post production.

Alternatively, you can also base your exposure while using the LCD set to preview in Video dynamic range so there is no need to worry even if you do not have a gray card. Shots exposed this way will then look the same when imported into Resolve and will need very little exposure correction.
Workflows

There are many powerful ways to use Blackmagic Cinema Camera with your favorite video software. The following steps detail one of the most common workflows.

Step 1. Shoot with Blackmagic Cinema Camera and record to CinemaDNG RAW files.
Step 2. Take the SSD out of the camera and dock it to your computer via a SSD dock with a fast Thunderbolt, USB 3.0 or eSATA connection.
Step 3. Bring the media into Resolve 9.
Step 4. Apply a basic grade in Resolve 9 and render out to Apple ProRes, Avid DNxHD or other formats.
Step 5. Edit the files in popular NLE software such as Apple Final Cut Pro, Avid Media Composer or Adobe Premiere Pro.
Step 6. When finished editing, export an XML or AAF file.
Step 7. Import the XML or AAF file into Resolve 9 and conform with the original CinemaDNG images for maximum creative control.
Step 8. Grade the edited timeline in Resolve 9 to complete the project.

If you have shot and recorded your clips in ProRes or DNxHD using the Film Dynamic Range, you can quickly turn it into Video or REC709 using the built in 3D LUT in Resolve 9. Just right click on the clip in Resolve’s timeline in the Color page and select “Blackmagic Cinema Camera Film to Rec709” from the 3D LUT menu.

Using Blackmagic Video Software

Your Blackmagic Cinema Camera includes three video applications from Blackmagic Design.

DaVinci Resolve 9, the world’s most powerful color correction, lets you take advantage of Blackmagic Cinema Camera’s wide dynamic range images that are perfect for color correction. Please refer to the DaVinci Resolve 9 manual provided in your software download or on disc.

Blackmagic Media Express 3 lets you perform simple video captures via the Thunderbolt port of your Blackmagic Cinema Camera. Please refer to the Media Express chapter in this manual.

Blackmagic UltraScope lets you perform waveform monitoring, while shooting, via the Thunderbolt port of your Blackmagic Cinema Camera. Please refer to the Blackmagic UltraScope chapter in this manual.
Important Information About SSD Speeds

Some SSDs can have up to 50% lower write speed than the manufacturer’s claimed speed, so even though the disk specifications claim a SSD is fast enough to handle video, in reality the disk is not fast enough for real time video data recording. Hidden data compression mostly affects recording and often these disks can still be used for real time playback.

Blackmagic Disk Speed Test measures accurately if your SSD will be able to handle uncompressed RAW video recording and playback. Blackmagic Disk Speed Test uses data to simulate the storage of video so you get results similar to what you will see when recording video to a disk. This will let you find models of SSD that work well for video recording. In our testing, we have found larger newer models of SSD, and larger capacity SSDs are generally faster. Blackmagic Disk Speed Test also tests the speed of disks connected to interfaces including Thunderbolt, USB 3.0 and eSATA docks, which can affect disk performance. Please check our web site at www.blackmagicdesign.com and click the support page to download the latest version of Blackmagic Disk Speed Test.

Use Disk Speed Test to get a great real world indication of your disk array performance.
About SSDs

Supported Disk Format

SSDs used by Blackmagic Cinema Camera must be formatted as either HFS+ or exFAT. These disk formats allow long clips to be recorded in a single file per clip. Simply connect the SSD to your computer with an external dock or cable adapter and format it as you would a regular disk. Make sure you back up anything important from your SSD as you will lose everything on it when you format it.

HFS+ is also known as Mac OS Extended. It is the recommended format for Cinema Camera as it supports “journaling”. In the event of a hardware or software malfunction, data on a journaled SSD is more quickly recovered and less likely to be corrupted in the first place. HFS+ is natively supported by Mac OS X. Windows computers can use HFS+ with the purchase and installation of MediaFour MacDrive software from http://www.mediafour.com.

ExFAT is supported natively by Mac OS X and Windows without needing to purchase any additional software. However exFAT does not support journaling.

Preparing SSDs on a Mac OS X computer

The Disk Utility application included with Mac OS X can format a drive in the HFS+ or exFAT formats. If you are shooting CinemaDNG RAW 2.5K video, be sure to choose the HFS+ format so you can quickly browse through the thousands of DNG files in the Finder of Mac OS X.

**Step 1.** Connect the SSD to your computer and dismiss any message offering to use your SSD for Time Machine backups.

**Step 2.** Go to /Applications/Utilities and launch Disk Utility.

**Step 3.** Click on the disk icon of your SSD and then click the Erase tab.

**Step 4.** Set the Format to “Mac OS Extended (Journaled)” or “exFAT”, type a Name for the new volume and then click Erase. Your SSD will quickly be formatted and made ready for use with Blackmagic Cinema Camera.

Preparing SSDs on a Windows computer

MacDrive software can format a drive in the HFS+ format on a Windows PC.

**Step 1.** Install MediaFour MacDrive and restart your PC.

**Step 2.** Connect the SSD to your computer.

**Step 3.** Choose Start>Computer and right-click on your SSD.

**Step 4.** From the contextual menu, choose MacDrive>Format Mac Disk.
Step 5. Select the SSD in the MacDrive Disk Manager and choose Initialize disk>Initialize as GPT.
Step 6. Choose "Automatically create an HFS+ volume" and click "Initialize Disk".
Step 7. Once the format has been completed, your SSD is ready for use with Blackmagic Cinema Camera.

The Format dialog box can format a drive in the exFAT format on a Windows PC.

Step 1. Connect the SSD to your computer.
Step 2. Choose Start>Computer and right-click on your SSD.
Step 3. From the contextual menu, choose Format.
Step 4. Set the file system to "exFAT" and the allocation unit size to 128 kilobytes.
Step 5. Type a volume label, select "Quick Format" and click "Start".
Step 6. Your SSD will quickly be formatted and made ready for use with Blackmagic Cinema Camera.

Recommended SSDs for RAW Recording

SSDs recommended for use with Blackmagic Cinema Camera and RAW 2.5K video recording include:

- Crucial 256GB C300
- Crucial 512GB M4 (firmware 009)
- Kingston 64GB SSDNow V+100
- Kingston 128GB SSDNow V+100
- Kingston 240GB SSDNow V+200
- Kingston HyperX 240GB
- Sandisk Extreme 480GB.

Please check the tech notes on the Blackmagic Design web site for the latest compatibility information.
Sun Shield

Your Blackmagic Cinema Camera includes a detachable sun shield to shade the touchscreen in bright conditions and ensure optimum viewing is possible at all times.

Place the sun shield over the rear of the camera and, with the shield positioned at the top, line up the locking tabs and gently push into the camera.

To remove the sun shield either:

**Option 1.** Hold the top of the shield in the middle and gently pull out, making sure it releases evenly on both sides.

**Option 2.** Position your thumbs above the locking tabs on the inside of the shield, gripping the outside of the shield with your fingers. Using your thumbs, gently press the locking tabs outwards using equal pressure, and then pull out the shield.

Do not pull the sun shield out one side at a time, as you may damage the locking tabs.

---

Carry Strap

Your Blackmagic Cinema Camera comes with a carry strap for convenient carrying of the camera when on the move from location to location.

To fasten, loop the end of the strap through the metal hook on the top of the camera, and secure through the plastic clasp to the desired length.
Blackmagic Cinema Camera Handles

The Blackmagic Cinema Camera has optional handles for shooting in locations where you need to move around quickly with your camera. The handles let you steady your shot and keep up with the action!

On the underside of the camera, locate the ¼” screw thread and insert the guide pin, locking the handles to the camera.
What Can I Do With the Thunderbolt Port on My Camera?

When connected to a Mac OS X computer with Thunderbolt technology, your Blackmagic Cinema Camera can be used as a powerful solution for video capture, waveform monitoring and color correction. Regardless of which recording format you choose on the camera, the Thunderbolt port always outputs HD1080p video in the uncompressed 10-bit format which is compatible with a wide range of popular video software.

The Blackmagic Cinema Camera Utility software installer installs the Blackmagic Media Express application for simple captures without the complexity of NLE software.

Blackmagic UltraScope software is also installed for waveform monitoring of your camera during recording and playback.

Video Capture

You can also use your favorite video capture applications to capture video from the Thunderbolt port of your Blackmagic Cinema Camera. Applications include Blackmagic Media Express, DaVinci Resolve, Adobe Premiere Pro CS6 and Apple Final Cut Pro 7. The “Using Blackmagic Media Express” chapter of this manual contains detailed instructions for performing simple captures with Media Express.

Waveform Monitoring

Blackmagic UltraScope software allows you to monitor almost every aspect of the video you record with your Blackmagic Cinema Camera. The “Using Blackmagic UltraScope” chapter of this manual contains detailed instructions to help you get the most out of waveform monitoring with your camera.

Color Correction

DaVinci Resolve 9 can directly capture video from the Thunderbolt port of your Blackmagic Cinema Camera. However if you are shooting RAW 2.5K Film, it would be best to take the SSD out of the camera and connect it directly to your computer to retain all quality of the original video.
What is Media Express?
Blackmagic Media Express 3 software is included with every Blackmagic Cinema Camera to perform video and audio capture to files. Blackmagic Media Express 3 is a great tool when you don’t need the complexity of NLE software, but simply want to capture the live video output of your camera’s Thunderbolt port.

The User Interface
Media Express can easily be scaled for different sizes of monitors or even small notebook screens. When you open Media Express, you’ll notice the log and capture, playback and edit to tape views are color-coded so you will know at a glance which mode is being used. The edit to tape view is not used by Blackmagic Cinema Camera but may be used with other Blackmagic Design capture and playback products.

Media List
The left “media list” always displays the scratch, any bins you have created and also any media you have imported or captured. Media can be displayed in Timecode List view or Thumbnail view and you can even filter media by favorites. The Search field makes it easy to find media by name or by attributes captured in the media metadata. The project name and format are shown in the bottom-left corner of the Media Express window.

The top-right pane always displays the video preview. Timecode is displayed at the top of the video preview pane.

Log and Capture
Click on the red Log and Capture tab. The video preview pane shows the source video from your Blackmagic Cinema Camera. Here you can enter metadata for the clips you will capture including name, description, favorite and more. Double-clicking a captured clip in the media list will automatically switch Media Express to Playback view.

Playback
In the green Playback view, the video preview pane shows the video of the clip being played. Click the favorites button to add to your favorites in the media list.
Capturing Video and Audio Files

Selecting Your Blackmagic Cinema Camera

If you have more than one Blackmagic Design capture product installed or connected to your computer, go to the Device menu in Media Express and select your Blackmagic Cinema Camera. In the example pictured on this page, an Intensity Extreme and a Blackmagic Cinema Camera are both connected to the same computer. Selecting your Blackmagic Cinema Camera will allow you to choose suitable video settings for your project.

Setting Up a Project

Before capturing any clips in Media Express, you will need to select the settings for your project. Go to Media Express>Preferences on Mac OS X. Any settings which are grayed out are only used with other Blackmagic Design capture products and are not required by your Blackmagic Cinema Camera.

With Blackmagic Cinema Camera, set the project video format to HD1080p and also set the frame rate. Select from a range of professional compressed and uncompressed capture file formats or even a DPX image sequence. Video will be captured in the chosen format and saved to a QuickTime movie on Mac.

Set the storage location for your captured video and audio and choose whether to stop capture or playback if dropped frames are detected.

Usually video applications stop playing video if you send them to the background. If you want Media Express to keep playing video, even if you open another application in the foreground, enable the checkbox to “Continue playback when in the background.”

The final options are not used by Blackmagic Cinema Camera as they relate to tape decks with RS-422 deck control.
Using Blackmagic Media Express

- **Media List**
- **Timecode List, Thumbnail and Favorites view**
- **Search Field**
- **VTR / deck timecode**
- **Video Preview**

**Media List**
- Project name, video format and frame rate

**Timecode List, Thumbnail and Favorites view**
- Clip Bins
- Mark In / Mark Out
- Grab Still Frame

**Search Field**
- Logging Information

**VTR / deck timecode**
- Capture options

**Video Preview**
- Transport Controls
- Audio channel enable/disable
- Audio Meters
- Remote indicator
Capture

Capturing video is easy, all you need to do is connect your Blackmagic Cinema Camera via a Thunderbolt cable, set the Media Express preferences and press the Capture button.

Open Media Express and set its preferences to the desired project video format.

Click the red Log and Capture tab and enter a description for your video into the Description field of the logging information area.

Click the “+” button next to the Description to add it to the automatic Name field. Click the “+” button next to any of the other fields that you wish to add to the Name field.

- You can increment the value in each of these fields by clicking on the corresponding clapper board icon. Alternatively you can type directly into any field to customize its name and number.
- The text in the automatic Name field will be applied to the clip(s) which are about to be captured.
- Click the “star” icon next to the Name field if you want to log the clip as a favorite.
- Click the “!” icon next to the Name field if you wish a clip name confirmation prompt to appear before every capture. This will provide you with the chance to change the clip name.

Set whether audio channels 1 and 2 are to be captured and then click the “Capture” button to start recording. The Clip, Batch and Log buttons are not used to capture from Blackmagic Cinema Cameras. They relate to capturing from tape decks with RS-422 deck control.

To end capture, click the “Capture” button again to automatically keep the clip. Alternatively press the “Esc” key if you want to be prompted to delete or save the clip.

The captured clips will be added to the Media List.
Using Blackmagic Media Express
Playing Back Video and Audio Files

Importing Clips
You can play back your video and audio files after capturing video or importing media into Media Express in any of the following ways:

- Double-click an empty area of the Media List.
- Right-click an empty area of the Media List and select Import Clip from the contextual menu.
- Go to the File menu, select Import and then Media Files.

Then select the clip(s) you wish to import from the Open Video Clip dialog box. The clips will appear in the Scratch area of the Media List. If you have created your own bins in the Media List, you can drag the clips into the desired bin.

If you want to import media directly to a bin, right-click within the desired bin and select Import Clip from the contextual menu.

If the files being imported do not match the frame rate and size of existing clips in the Media List, you will be prompted to create a new project and to save the current project.

The Final Cut Pro XML import option is not used by Blackmagic Cinema Cameras. This option relates to capturing from tape decks with RS-422 deck control.

The CMX EDL import option is not used by Blackmagic Cinema Cameras. This option relates to capturing from tape decks with RS-422 deck control.

Playing Back Single and Multiple Clips
You can play back files in the video preview pane of Media Express, and monitor audio via the default sound output of your computer. Alternatively use a media player such as QuickTime Player, iTunes, Windows Media Player or VLC to play back your files in full screen.

To play back a single clip, double-click the clip in the Media List. Alternatively, select the clip in the Media List and press the space bar on your keyboard or the play button in the transport controls.

To play back multiple clips, select the clips in the Media List and then press the space bar on your keyboard or the play button in the transport controls.

Your video will play back in the video preview pane of Media Express. During playback, the audio channels being monitored can be switched on or off via the track enable/disable buttons.
Browsing Media

In the Media List, you can view your clips in Thumbnail view or Timecode List view by clicking on the desired view button at the top-right of the Media List.

**Thumbnail View**

Thumbnails are the most intuitive way to display your clips. To get information for a clip, hover your mouse over the clip’s thumbnail and then click on the popup info icon which will appear at the bottom-right of the thumbnail. Click the info bubble to hide it.

**List View**

You can view your clips in Timecode List view by clicking on the Timecode List button at the top-right of the Media List. Use the horizontal scroll bar at the bottom of the Media List to view all the columns of information for your clips, including: in and out points, video format, audio channels, field dominance and logging information.

**Creating and Using Bins**

To create a bin for your clips, right click an empty spot in the Media List and select “Create Bin.” Type in a name for the new bin.

You can move clips from the Scratch, or from one bin to another, by dragging the clip icons to the desired bin. If you want a clip to appear in more than one bin, import the same clip again by right-clicking on the bin and choosing “Import Clip”.

By default, logged clips appear in the Scratch. If you want to log clips and have them appear in a new bin, right-click the new bin and choose “Select As Log Bin”.

**Creating and Using Favorites**

In the Log and Capture tab, click the “star” icon next to the Name field if you want to capture a clip as a favorite.

In the Playback tab, clicking the “star” icon will make the clip a favorite if it is selected in the Media List. Click the “star” icon again to deselect it as a favorite.

Clips marked as favorites will show a yellow star in their icon in Timecode List view and Thumbnail view.

Once you have marked clips as favorites, click on the gray Favorites star button at the top of the Media list and it will turn yellow. All clips in your Media List will be hidden except for those marked as favorites. This is similar to creating a playlist and makes it easy to only play back your favorite clips.
Deleting Clips and Bins

To delete clips, select the unwanted clips and press the forward delete button on your keyboard. This will only delete the clips from the Media List and they will safely remain on your disk storage.

To delete bins, right-click within a bin and choose “Delete Bin”. This action will delete the bin and any clips it contained. This will only delete the clips from the Media List and they will safely remain on your disk storage.

Searching the Media List

Clips can easily be found in a project by typing the name of your clips in the Search field at the top of the Media List. When used in conjunction with the favorites feature, the search will be confined to your favorite clips so you will see a shorter list of found clips.
What is Blackmagic UltraScope?

Now with Blackmagic Cinema Camera you get the incredible features of Blackmagic UltraScope which you can even use with compatible iMac and MacBook Pro notebook computers with Thunderbolt technology! Blackmagic UltraScope software is installed by the Blackmagic Cinema Camera Installer.

Previously broadcast quality television and post production scopes were incredibly expensive custom solutions that only let you see one scope at a time on a tiny screen! Some scopes look ugly and don’t really look good in front of your client. With Blackmagic UltraScope, you get 6 wonderful scopes that let you see all aspects of your video signals, which is perfect for checking levels on your Blackmagic Cinema Camera while shooting. Any adjustments made to the camera can immediately be seen with Blackmagic UltraScope!

Blackmagic UltraScope software provides waveform monitoring of the video output of your Blackmagic Cinema Camera. Simply connect a Thunderbolt cable between your Blackmagic Cinema Camera and a Mac computer and away you go!

Installation Requirements for Mac OS X

Blackmagic Cinema Camera connects to Mac OS X computers with Thunderbolt technology.

The Blackmagic UltraScope software interface requires a computer display with a minimum resolution of 1280 x 800 pixels to view two scopes simultaneously. Blackmagic Design recommends viewing all 6 scopes simultaneously by using a computer display resolution of 1920 x 1200 or 1920 x 1080 pixels.

Please see the support pages at www.blackmagicdesign.com for a comprehensive list of the latest minimum system requirements for Blackmagic UltraScope for Mac.
Using Blackmagic UltraScope

Blackmagic UltraScope Interface

1. Parade Display
2. Waveform Display
3. Vectorscope Display
4. Histogram Display
5. Error Logging
6. Audio Metering Display
7. Picture Display
Understanding Blackmagic UltraScope Views

Blackmagic UltraScope has two different views available depending on your workflow needs and screen resolution. You have the choice of viewing six displays in “Full Screen” view, or for more compact viewing, choose any 2 displays in “2-up” view.

The display view can be selected from the View menu.

Choose Full Screen to enter Full Screen view. If this option is unchecked, 2-up view will be displayed. You can quickly switch between Full Screen view and 2-up view by using the hot key CMD-F on Mac OS X.

In 2-up view, select the desired left and right scopes by opening the View menu or by right-clicking anywhere in the UltraScope window. Make your selections from the Left View and Right View menu options.

If you want the scopes to swap sides, select the left or right view and set it to be the same as the other view. The scopes will swap sides. This is because the 2-up view always shows two different scopes and never displays the same scope in both the left and right views.

Screen Resolution Requirements for Display Views

- Full Screen view: 1920 x 1200 pixels or 1920 x 1080 pixels. If your monitor doesn’t support these resolutions, then Full Screen view will not be available.
- 2-up view: minimum resolution of 1280 x 800 pixels.
Using Blackmagic UltraScope

Zoom Function

Blackmagic UltraScope allows you to zoom in on various displays for a more detailed analysis. This helpful function will also pan and zoom the graticules for each display in high resolution.

The zoom function is available in the Parade, Waveform, Vectorscope and Picture displays.

To zoom in, simply click on the bottom right of each respective display. Now you will be able to view the display in finer detail. Drag the mouse within the display area to pan around the zoomed display. Clicking again will return the display back to its normal view.
Blackmagic UltraScope is included for use with your Blackmagic Cinema Camera so you can always use it on set whenever your computer is connected to the camera’s Thunderbolt port. The following pages explain how each waveform display is used for tasks such as editing and color correction, as well as with your camera, so you get a deeper understanding of how each type of waveform display can help you.

1. Parade Display

Parade Display is perfect for checking for illegal colors and checking levels.

Press the RGB button to display the full height of each color channel as red, green and blue. Monitoring the levels of each red, green and blue color channel makes it easy to view color balance in the blacks, mids and whites of the video signal. Parade Display enables you to identify details common to the red, green and blue channels.

It’s often important to make sure you’re not clipping the video levels. Make sure the video is full level but not clipped. You can turn on the GAMUT function, and any illegal levels will be highlighted in bright red, so they are easy to see. Instructions for setting gamut limits can be found in the Error Logging Display section of this manual. If you want to increase the video level, then make sure it doesn’t go above upper RGB limit or you will encounter illegal levels. Some equipment won’t let you generate illegal 100% RGB levels, however other equipment will. Blackmagic UltraScope lets you see illegal levels whenever they occur.

Illegal video can also happen in blacks as well as whites. Some equipment produces black levels which can be lowered below the black point of 0%. The levels will be shown as bright red if this falls below the lower gamut limit and the GAMUT warning mode is enabled. If you observe illegal black levels, just add some “lift” or gain to eliminate them but check the 100% graticule level to make sure the whole video signal has not lifted and generated illegal colors in the whites.

To check levels, simply press the YUV or YUV+ button.

The COLOR setting switches the RGB display to color rather than traditional black and white. When the COLOR setting is used with the YUV or YUV+ display, luma (brightness) remains white, B-Y (difference between blue and luma) appears blue and R-Y (difference between red and luma) appears red. The COLOR setting is not a professional setting and should usually be switched off, especially when showing video to clients.
2. Waveform Display

The Waveform Display is similar to traditional composite waveform monitors seen in many broadcast studios.

On Mac OS X, B/W is always selected to show the luminance view, which provides a digitally encoded waveform similar to traditional luminance waveform monitors. The luminance view is very useful when adjusting luma (brightness) levels in an image. Turn on the GAMUT function, and any illegal luma levels will be highlighted in bright red, so they are easy to see. Instructions for setting luma limits can be found in the Error Logging Display section of this manual. Traditional luminance waveform monitors only supported composite analog standard definition video. However UltraScope’s luminance view works in high definition as well as standard definition, so you have a consistent and easy way to adjust luma levels even when monitoring high definition digital video formats!
3. Vectorscope Display

The Vectorscope Display uses a vector view to show the colors in a video signal. You can see color bar video levels by using the color boxes in the graticule. All you need to do is select 75% or 100% color bars, depending on the standard of color bar test signals used in your facility!

Some people think you can use a vectorscope to check for illegal levels. However, this is not correct, and the Parade Display should be used, and set to RGB, for checking for illegal colors. The reason you cannot use a vectorscope to check for illegal levels is that both chroma and luminance values are required. For example, colors near the white or black points in video cannot be as saturated as the much stronger colors, which can be used in the mid-grays. Because Vectorscope Display only shows colors, and not luminance values, it cannot be used to check for illegal colors.

Vectorscope Display lets you see if your video is correctly white-balanced or if there is a color tint. If your video has a color tint, the Vectorscope display will drift off-center, and you might see two center dots. Normally, the blanking in the video signal will create a dot in the center of the vector scope, and this is because the blanking in the video is black video without any color. Blanking provides a useful reference point to help recognize areas of black video without any color information.

If your video has a color tint, you should see the blacks move off-color and off-center. The degree of shift represents the amount of color tint in your video, and you can see the shift in both the white and black details of your video. This makes Vectorscope Display valuable for removing color tint and regaining correct white balance.

Vectorscope Display lets you push colors in your video to the limits, without accidentally adding unwanted color tints to blacks and whites. While color balance can be monitored on both the RGB Parade Display and Vectorscope Display, color balance issues will often be easier to see in Vectorscope Display.
4. Histogram Display

Histogram Display is most familiar to graphic designers and camera operators. Histogram Display shows the distribution of white to black information and lets you monitor how close the detail is to being clipped off in the whites or blacks of the video. Histogram Display also lets you see the effects of gamma changes in the video.

Black video is shown on the left of the display, and whites are shown on the right. All video should usually be found between the 0% and 100% intervals of the Histogram Display. Your video is being clipped if it moves below 0% or above 100%. Video clipping can be really bad, when you’re on a shoot, as detail in the blacks and whites must be preserved if you subsequently want to perform color-correction in a controlled environment. When shooting, keep the video above the black clip, and below the white clip, so you can have more freedom later to adjust colors without whites and blacks appearing flat and lacking in detail.

When shooting video, you might decide to clip your video, and in which case Histogram Display will show the effect of clipping the video, and how much it is being clipped. You can even use gamma to create a similar look, with less clipping, while retaining more detail.

You cannot really use Histogram Display to check for illegal levels, although you can use it to see illegal blacks and whites. Histogram Display does not show colors and so the histogram might appear to show legal levels, even though your video may contain illegal colors. Again, RGB Parade Display provides the best way to watch out for illegal levels as it shows them in both the color and luminance elements of the video signal.

The HIGH and LOW buttons simply control how bright the histogram appears on your computer display. If you find the white area of the histogram is too bright in a dark studio, choose LOW for a more comfortable brightness level.
5. Error Logging Display

Error Logging records errors in video and audio and is indispensable when reviewing video and for unattended operation. Errors may be logged for color, brightness or audio threshold levels as well as loss of video signal, change of video format or audio silence. After setting the parameters which define when an error should be logged, you can choose to start or stop error logging, save the log to a file, or clear the log. These functions can be selected from the buttons in the Error Logging Display or from the Error Logging pulldown menu.

Errors are recorded against timecode and time of day to make them easy to find. If the timecode is not present, errors can be found by reviewing the time of day at which they were recorded. As computer clocks can drift, it is a good idea to inspect the Date & Time settings on your computer, and set the clock to synchronize with an Internet time server to ensure accurate time of day logging.

In the Full Screen view, Histogram Display and Error Logging Display share the same area of the UltraScope interface. Select the LOGGING button, below the Histogram Display, to switch to the Error Logging Display. Select the HISTOGRAM button, below the Error Logging Display, to switch back to the Histogram Display. After quitting and reopening the UltraScope application, the last viewed display will be made visible again, i.e., either Histogram or Error Logging.

In 2-up view, Histogram Display and Error Logging Display can be viewed simultaneously and so there are no LOGGING or HISTOGRAM buttons.

When viewing the Error Logging Display for the first time, the display will initially be blank other than for some column headings. Select the START button to commence logging. In Full Screen view, you can switch back to the Histogram Display and UltraScope will continue to perform error logging until you choose to stop it.

When error logging is being performed, the STOP button replaces the START button. When the STOP button has been selected, you can choose to START again and any new errors will be appended to the existing log. When error logging has been stopped, you can choose to SAVE the log to a CSV file or alternatively CLEAR the log. The SAVE and CLEAR buttons will not appear if no errors have been recorded. The CSV file can be analyzed in many applications, including spreadsheet and database software.

By default, error logging is performed using the EBU-R103 standard, which is set down by the European Broadcasting Union. This standard is popular worldwide and is commonly used as a template for making new error logging profiles.
How to Customize Error Logging

To customize error logging, go to the Error Logging menu and choose Profiles to open the Error Logging Profiles window. Saved profiles appear in the profile list at the left and the current, active profile appears in bold above the list.

The standard EBU-R103 profile cannot be deleted or modified and is grayed out. You can add a profile by clicking the add (+) button and typing a name for your profile. The new profile will initially contain the same parameters as the EBU-R103 profile, but these can be changed as required.

Under the Gamut tab, upper and lower limits can be adjusted as a percentage of IRE units for RGB, Luma and Chroma. Set the minimum time in milliseconds (ms) for which these conditions must be sustained before being logged as errors. Set the percentage area, of pixels in error to total pixels in a frame, below which errors can be ignored. The Area setting acts like sensitivity.

Under the Audio tab, the maximum audio level can be set in decibels (dBFS) as can the audio level below which audio is regarded as silence. Set the minimum time in milliseconds (ms) for which these conditions must be sustained before being logged as errors.

Under the Video tab, loss of video signal and change of video format can be logged as errors.

Under the Notes tab, write a brief description of the new profile to help distinguish it from other profiles.

To modify a new or existing profile, ensure it is selected and then change its parameters as desired. Press Save to save these changes or choose Revert to leave the profile unchanged.

Choosing Save saves the changes to the profile but does not determine which profile is active. To activate a profile, select it from the profile list and then choose Set Active.

You can delete a profile by selecting it in the profile list and clicking the delete (−) button.
6. Audio Metering Display

Audio Metering Display shows you the audio levels in the embedded audio of the camera’s video signal. The 2 channels of embedded audio from your Blackmagic Cinema Camera are de-embedded and then displayed in either dBFS or VU format. The VU button switches between dBFS and VU audio metering standards.

dBFS is essentially a meter of the overall digital audio signal and is common on modern digital equipment. The VU meter shows average signal levels, is easy to use and very common on older equipment. VU is calibrated to the SMPTE recommendation of a 1 kHz tone test signal set to -20 dBFS.

The right hand audio scope can monitor two channels of audio. The audio scope presents audio in an X-Y view so you can see audio balance issues, out of phase conditions and whether an audio track is mono or stereo. Mono audio should appear as a single, vertical, “in phase” line. If the line is horizontal, then your audio is “out of phase” and could cancel out (i.e., loss of audio) when received by downstream equipment. Audio phase is one of the most common audio faults in large facilities, where cables can be incorrectly connected.

When monitoring stereo audio, the Audio Metering Display will puff out a little like a flower, highlighting the difference between the left and right audio channels. The more stereo sound is contained in the audio track, the more circular the display will appear. If the audio contains minimal stereo content, then the display will appear more concentrated around the vertical axis.

While spoken dialog tends to appear as a vertical line, music with plenty of stereo content will puff out. This is because mono audio is L+R, and will display on the vertical axis, whereas stereo content is L-R, and will display on the horizontal axis to show the stereo difference.
7. Picture Display

The Picture Display is a handy confidence monitor so you can see the video that is being received by Blackmagic UltraScope. The Picture Display has three settings: COLOR, B/W (black & white) and BLUE (Blue Only).

Set to COLOR or B/W depending on the needs of your facility. Black & white is popular for use in color correction studios so clients don’t get confused when seeing multiple color displays and not understanding which color display is the correct, color-calibrated display. You may wish to select B/W so there is only a single, calibrated, color display in the room. The black & white display can also provide a useful visual reference.

Blue Only is used with color bar test signals for setting hue on playback decks. When adjusting hue, make sure all the blue bars are a constant brightness to attain the correct hue level.

Blue Only can also be used for evaluating noise levels from your camera. Blue has the least amount of signal level, in a color video signal, and so is more susceptible to noise. The BLUE setting can provide a good way to check on noise levels in a video signal.

Lastly, the video standard is displayed on the left side of the Picture Display, so you can verify the video standard, and confirm you’re monitoring the correct video feed.
Getting Help

The fastest way to obtain help is to go to the Blackmagic Design online support pages and check the latest support material available for your Blackmagic Cinema Camera.

Blackmagic Design Online Support Pages

The latest manual, software and support notes can be found at the Blackmagic Support Center at www.blackmagicdesign.com/support.

Contacting Blackmagic Design Support

If you can't find the help you need in our support material, please use the "Send request" button, on the support page for your Blackmagic Cinema Camera, to email a support request. Alternatively, call your nearest Blackmagic Design support office at www.blackmagicdesign.com/company.

Checking the Software Version Currently Installed

To check which version of Blackmagic Cinema Camera Utility software is installed on your computer, open the About Blackmagic Cinema Camera Utility window.

- On Mac OS X, open Blackmagic Cinema Camera Utility from the Applications folder. Select About Blackmagic Cinema Camera Utility from the application menu to reveal the version number.
- On Windows 7, open Blackmagic Cinema Camera Utility from your Start menu. Click on the Help menu and select About Blackmagic Cinema Camera Utility to reveal the version number.

How to Get the Latest Software Updates

After checking the version of Blackmagic Cinema Camera Utility software installed on your computer, please visit the Blackmagic Support Center at www.blackmagicdesign.com/support to check for the latest updates. While it is usually a good idea to run the latest updates, it is a wise practice to avoid updating any software if you are in the middle of an important project.

Battery Replacement

The built-in camera battery is not user-servicable. Should the battery require replacement, you will need to send it to your nearest Blackmagic Design service center for replacement. If the camera is outside of its warranty period, the battery replacement will incur a small service fee for the cost of the battery, labor and return of the camera to you. Please contact Blackmagic Design Support to find out details of where to send your camera, how to package it safely and how much the replacement will cost in your country.
Replacing the Fan

Your camera contains a fan, which is necessary for cooling. If you detect that the fan is not working, or that it is making a strange noise, switch off the camera and order a replacement fan by contacting Blackmagic Design Support. You should use an anti-static strap to avoid damaging the camera while opened.

To replace the fan, start by switching off the camera and then remove any external cables.

Place the camera upside down on a bench, with the tripod hole facing up, and the touchscreen facing towards you. You will see a metal panel labelled "Fan". This panel is attached to a fan module inside the camera. Remove the four screws from this panel using a number 01 size Phillips head screwdriver. Thread-locking fluid has been applied to the screws which will require additional force to unscrew them. Keep the screws as you will need them again.

Gently lift the fan module up and out of the camera, taking care NOT to pull the wires that connect to the inside of the camera. Accidentally pulling on these wires could cause them to become unplugged from an inaccessible location inside the camera, which would need to be fixed by a Blackmagic Design service center.

Locate the white plastic plug a short distance along the wires from the fan. Pull the plug apart using both hands so that no stress is placed on the wires that continue inside the camera. You can now discard the old fan module.

Connect the white plastic plug to the wires of the replacement fan module. Reinstall the fan module in its hole with the "Fan" label the right way up. The fan module can only be installed in one orientation. Reinstall the four screws into the fan plate to finish replacing the fan.

Switch on the camera and you should feel a gentle flow of air coming from the vent holes in the fan module.
12 Month Limited Warranty

Blackmagic Design warrants that this product will be free from defects in materials and workmanship for a period of 12 months from the date of purchase. If a product proves to be defective during this warranty period, Blackmagic Design, at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. The Customer shall be responsible for packaging and shipping the defective product to a designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer shall be responsible for paying all shipping charges, insurance, duties, taxes, and any other charges for products returned to us for any reason.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design representatives to install, repair or service the product, b) to repair damage resulting from improper use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or integrated with other products when the effect of such a modification or integration increases the time or difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC DESIGN IS NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS PRODUCT. USER OPERATES THIS PRODUCT AT OWN RISK.

© Copyright 2012 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘Multibridge Pro’, ‘Multibridge Extreme’, ‘Intensity’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and product names may be trade marks of their respective companies with which they are associated.